Chordiant Foundation Server &
Call Centre Advisor (Browser Edition)

Installation, Configuration and Deployment Guide
This document describes products and services of Pegasystems Inc. It may contain trade secrets and proprietary information. The document and product are protected by copyright and distributed under licenses restricting their use, copying distribution, or transmittal in any form without prior written authorization of Pegasystems Inc.

This document is current as of the date of publication only. Changes in the document may be made from time to time at the discretion of Pegasystems. This document remains the property of Pegasystems and must be returned to it upon request. This document does not imply any commitment to offer or deliver the products or services described.

This document may include references to Pegasystems product features that have not been licensed by your company. If you have questions about whether a particular capability is included in your installation, please consult your Pegasystems service consultant.

For Pegasystems trademarks and registered trademarks, all rights reserved. Other brand or product names are trademarks of their respective holders.

Although Pegasystems Inc. strives for accuracy in its publications, any publication may contain inaccuracies or typographical errors. This document or Help System could contain technical inaccuracies or typographical errors. Changes are periodically added to the information herein. Pegasystems Inc. may make improvements and/or changes in the information described herein at any time.

This document is the property of:
Pegasystems Inc.
101 Main Street
Cambridge, MA 02142-1590

Phone: (617) 374-9600
Fax: (617) 374-9620
www.pega.com

Chordiant Foundation Server and CCABE
Document: Installation, Configuration and Deployment Guide

Chordiant Foundation Server 6.7.0

Updated: June 6, 2012
Contents

Chapter 1: Introduction ........................................................................................................... 1-1
Pega Mesh® ......................................................................................................................... 1-3
Documentation ................................................................................................................... 1-4

Chapter 2: Preparing the Environment ................................................................................. 2-5
Pre-Requisite Software Installation ...................................................................................... 2-6
WebSphere Profile Creation ................................................................................................. 2-7
WebLogic Domain Creation ................................................................................................. 2-14
Configuring Database Server .............................................................................................. 2-15
  Configuring Oracle .................................................................................................................. 2-15
  Configuring DB2 for Chordiant ............................................................................................ 2-15
Preparing Chordiant Database ............................................................................................. 2-15
Configuring OpenDS Directory Server ................................................................................ 2-25
Configuring Web Server for Cluster .................................................................................... 2-26
  Configuring IBM HTTP Server for WebSphere Cluster ....................................................... 2-26
  Configuring Apache HTTP Server for Weblogic Cluster ...................................................... 2-26

Chapter 3: Configuration Notes ............................................................................................ 3-27
MDB Configuration .............................................................................................................. 3-28
  For WebSphere Application Server ..................................................................................... 3-28
  For WebLogic Server .......................................................................................................... 3-28
Performing Set-up and Configuration .................................................................................. 3-29
  Development Environment Configuration ........................................................................... 3-29
  Production Environment - Cluster Configuration ............................................................... 3-29
  FMX and CTI Configuration ............................................................................................... 3-30
JSF configuration for WebSphere 8 ...................................................................................... 3-33
Miscellaneous Configurations .............................................................................................. 3-34
  WebLogic Upgrade ............................................................................................................. 3-34
  EJB/JEE Timer Service ....................................................................................................... 3-34
  Comet ................................................................................................................................... 3-34
  Changing Configurations Dynamically .............................................................................. 3-34
  Browser Agnostic Application ............................................................................................ 3-34

Chapter 4: Installing the Chordiant Decision Management .................................................. 4-35
Overview .............................................................................................................................. 4-36
Installing CDM ..................................................................................................................... 4-37
Pre-Installation Task .......................................................... 4-37
CDM Installation .............................................................. 4-37
Configure Database ......................................................... 4-37
Run CDM J2EE Installer ................................................... 4-37

Verification of CDM Installation ......................................... 4-40
Deploy Decision Logic to CDM ........................................... 4-40
Test Decision Logic ......................................................... 4-41
Run Decision Tester ......................................................... 4-41

Chapter 5: Configuring Multiple Web Applications .................. 5-43
Configuration Steps ......................................................... 5-44
Behavior of Multiple Web Application Configurations .............. 5-46

Appendix A ........................................................................... A-1
RAD ................................................................................... A-2
RAD publish fails when setting up the following .................... A-2
WebLogic Application Server on Development Environment ... A-4
Error when setting up Chordiant Projects ............................. A-4
Network ............................................................................ A-5
Security Error Message ..................................................... A-5

Appendix B: Required Information Checklist .......................... B-1
Application Server ............................................................ B-2
Database ............................................................................ B-3
LDAP ................................................................................ B-4
JMS Server ........................................................................ B-5
JDK .................................................................................. B-6
Chapter 1:
Introduction

The *Chordiant Foundation Server & Call Center Advisor (Browser Edition) – Installation, Configuration and Deployment Guide* provides the information you need to install Chordiant Foundation Server along with CCABE and set up your development and production environment so you can begin developing and using Chordiant solutions.

The Tools Platform runs under RAD, MyEclipse and MyEclipse Blue, an open integrated development environment (IDE), enabling tool integration, productivity enhancement tools, and support for open technologies.
Overview of Installation Process as described in this Document:

1. Chapter 2 details steps for installing and configuring third-party software.

2. Chapter 3 explains required configurations to enable certain features.

3. Refer the *Foundation_Server_DE_Guide* for setting up your Development Environment (DE).

4. Refer the *Foundation_Server_PE_Guide* for setting up your Production Environment (PE).

5. Chapter 4 talks about installing and integrating Chordiant Decision Management (CDM).

6. Chapter 5 talks about configuring multiple Advisor-like applications.
The Pega Mesh® is Pega’s online community of developers and users. Visit the Pega Mesh®, located at https://mesh.pega.com to:

- Download daily builds or milestone releases
- Participate in online discussions about new or existing features
- Learn about new features being developed
- Participate in new feature development
- Read documentation
- Log a bug
- Fix a bug
- Find out how you can participate

Learn more about how you can be part of the solution on the Pega Mesh® site.
Documentation

Before you begin the installation process, be sure that you have reviewed this guide and understood its contents. If you have any questions, contact Pegasystems Customer Support (support@pega.com) or your customization expert. The Chordiant Foundation Server documentation is available from a number of sources:

- After installing the software, to access help files in any of the IDE (RAD, MyEclipse and MyEclipse Blue), select Help | Help Contents. You should see a link to Chordiant Documentation in the Help table of contents.

- You can view and print the updated Foundation Server documentation from Product Documentation page on the Pega Mesh®.
Chapter 2:
Preparing the Environment

This chapter describes preparation tasks required to set up a development and production environment for running Chordiant Foundation Server based applications. To do so, install and configure third-party applications like application server, database, and LDAP. In addition, your application may require the installation of other supporting software.

Notes:

Deployment of Chordiant Foundation Server and any associated applications assumes that your network topology and server layout are in accordance with IT industry security considerations and best practices.

Be sure to read your third-party installation and setup instructions carefully. You may need to set environment variables and download patches or fixes in order to complete your installation successfully.

Where applicable, all software must be separately licensed from the third-party.
Pre-Requisite Software Installation

Obtain the required software from respective vendors and install the same following the guidelines of the vendor.

**Notes:**

Be sure to check the Tech Stack page for this release to ensure you are using certified software versions.

Do not include spaces in the installation directory name. Some modules in the Chordiant Foundation Server do not accept spaces in the directory name.

When installing third-party applications, we strongly recommend that you note your settings on the form provided in the section *Required Information Checklist*. You will need this information later. Maintain separate lists for Development and Production environments.

The following table lists the minimum required software for both Development and Production environments.

<table>
<thead>
<tr>
<th>Environment</th>
<th>Development</th>
<th>Production</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Application Server</strong></td>
<td>Weblogic</td>
<td>WebSphere</td>
</tr>
<tr>
<td><strong>Database</strong></td>
<td>Oracle</td>
<td>Oracle DB2</td>
</tr>
<tr>
<td><strong>Operating System</strong></td>
<td>Windows</td>
<td>Solaris</td>
</tr>
<tr>
<td><strong>IDE</strong></td>
<td>MyEclipse</td>
<td>MyEclipse Blue RAD</td>
</tr>
<tr>
<td><strong>LDAP</strong></td>
<td>OpenDS.Directory Server</td>
<td></td>
</tr>
<tr>
<td><strong>Other</strong></td>
<td>Web 2 Feature Pack*</td>
<td>Web 2 Feature Pack*</td>
</tr>
</tbody>
</table>

*Figure 2-1: Third-Party Applications Required*

*Web 2 Feature Pack is required if you want to use Comet instead of NWP.*
WebSphere Profile Creation

If you are using WebSphere Application Server, you will first need to create a profile using the Profile Management Tool. Here are the steps for how to create and delete WebSphere profiles.

Creating WebSphere Profile for Development Environment

1. Launch the Profile Management Tool
   - In RAD, select Windows | Preferences | Server | WebSphere Application Server and click Run Profile Management Tool.
   - If you are using MyEclipse Blue as your IDE along with WebSphere Application Server, run the pmt.bat file, located in your {WebSphere_Home}/bin/ProfileManagement directory.

2. At the Welcome to the Profile Management Tool screen, click on Launch to Profile Management Tool.

3. Click Create to display the Environment Selection dialog.
4. Select your environment and click Next.

5. Accept the Typical profile creation option. Then click Next.
Preparing the Environment — WebSphere Profile Creation

6. At the **Administrative Security** screen, clear the **Enable administrative security** checkbox. Click **Next** to continue.
7. Review the **Profile Creation Summary** screen. If the summary is correct, click **Create** to create the profile.

8. The **Profile Creation Complete** screen displays that the profile was created successfully. You can check the **Create another profile** checkbox or click **Finish** to run an installation verification test.

9. View the newly created Profile in the list and click **OK**.

**Deleting WebSphere Profile for Development Environment**

You may need to delete a profile if you no longer need to use it. Follow the steps below to delete the profile.

1. Stop the server associated with the profile.

2. If you are using RAD, follow the steps below.
   - Click **Windows | Preferences | Server | WebSphere Application Server** and select the profile you want to delete and then click **Delete**.
   - Confirm your actions by clicking **Yes** or **No**.

3. If you are using MyEclipse Blue as your IDE along with WebSphere Application Server, follow the steps below.
   - Go to `{WebSphere_Home}/bin` through command prompt. For e.g. C:\IBM\WebSphere\AppServer\bin.
   - Issue the following command
     
     ```
     manageprofiles.bat -delete -profileName <Profile_Name>
     ```
     
     **E.g.**

     ```
     C:\IBM\WebSphere\AppServer\bin>manageprofiles.bat -delete -profileName AppServer01
     ```
     
     **Figure 2-7:** Deleting WAS profile through command prompt.

     - To remove the entry of deleted profile, issue the following command from `{WebSphere_Home}/bin` folder

     ```
     manageprofiles.bat -validateAndUpdateRegistry
     ```

     **Note:** If you have not removed the entry from registry, you will not be able to create a new profile with the same name.
WebSphere Profile Management in Production Environment

For Chordiant Foundation Server based applications, you need to create a Deployment Manager (DMgr) Profile, a Default Profile and then federate (add) the default profile to the Deployment Manager (DMgr).

The deployment manager provides a single administrative interface for a logical group of application servers on one or more machines.

To create a Deployment Manager (DMgr) Profile:

1. Go to {WebSphere_Home}/bin folder
2. Use manageprofile command as shown below to create a DMgr Profile.

   ./manageprofiles.sh -create -templatePath
   /{WebSphere_Home}/profileTemplates/dmgr -profilePath
   /{WebSphere_Home}/profiles/<Profile_Name>  -profileName
   <Profile_Name>

   Where,

   <Profile_Name> is the name of DMgr Profile.

   E.g.

   ./manageprofiles.sh -create -templatePath
   /export/vol01/WAS7/profileTemplates/dmgr -profilePath
   /export/vol01/WAS7/profiles/DMGR_FS67 -profileName
   DMGR_FS67

3. Once it will be created it will result in success message along with location of log file (AboutThisProfile.txt). The log file contains all the Port Details for DMgr and other information.

   The default profile provides the necessary configuration files for starting and managing the application server that it contains. It also provides the services and resources that are required to deploy and run enterprise applications.

To create a Default Profile:

1. Go to {WebSphere_Home}/bin folder
2. Use manageprofile command as shown below to create a Default Profile.

   ./manageprofiles.sh -create -templatePath
   /{WebSphere_Home}/profileTemplates/default -profilePath
   /{WebSphere_Home}/profiles/<Profile_Name>  -profileName
   <Profile_Name>

   Where,
<Profile_Name> is the name of Default Profile.

E.g.

./manageprofiles.sh -create -templatePath
/export/vol01/WAS7/profileTemplates/default -profilePath
/export/vol01/WAS7/profiles/STD_FS67 -profileName
STD_FS67

3. Once it is created, it will result in success message along with location of log file (AboutThisProfile.txt). The log file contains all the Port Details for DMgr and other information.

You can use the addNode script to federate a profile into a Network Deployment cell. When you federate a profile into a cell, a node agent server is created to monitor the application server. The node agent server serves as an intermediary between the application servers on the node and the deployment manager that oversees the entire cell.

To federate (add) a Default Profile to a DMgr:

1. Make sure that DMgr server is running. To start the server, go to {DMgr_Profile}/bin folder and issue the command ./startManager.sh.

2. Go to the location {Default_Profile}/bin and issue the command ./addNode.sh <server_name> <SOAP Port>

Where,

<server_name> is the name of server where DMgr is running, and

<SOAP Port> is the SOAP Port of DMgr.

We can get the Port details from DMgr log file.

3. It will result in a message “Node <NODE_NAME> has been successfully federated.” which ensures that node federation is successful. It will also start the Default Profile server.

Note: For a Cluster Setup you need to create one DMgr profile and two or more Default Profiles, each will be federated to the same DMgr.

Default Profile can exist on same server on which DMgr is present or on different server also.

In case Default profile is on another server make sure that time difference between 2 machines should not be more than ±5 minutes, otherwise it will not federate.
**Note:** In a single server more than one Default profile can be created and all federated to DMgr on same server. Such architecture is known as **Horizontal Cluster**.

If there is only one Default profile on each server of the cluster then this architecture is **Vertical Cluster**.

If a profile is no longer required you can delete it

4. Go to `{WebSphere_Home}/bin` folder.
5. Issue the command:
   ```bash
   ./manageprofiles.sh -delete -profileName <profile_name>
   ```
6. Where, `<profile_name>` is the name of Profile to be deleted.

**Note:** Delete command is same to delete any kinds of profile.

7. To remove profile entry from the registry, issue the below command:
   ```bash
   ./manageprofiles.sh -validateAndUpdateRegistry
   ```

**Note:** If you have not removed the entry from registry, you will not be able to create a new profile with the same name.
WebLogic Domain Creation

If you are using WebLogic Application Server, you will first need to create a domain.

Creating WebLogic Domain for Development Environment

For Development Environment, Weblogic domain will be created once when you set up the workspace after installing Chordiant Foundation Server plug-ins.

Creating WebLogic Domain for Production Environment

1. Run the command ./config.sh, under 
   {Weblogic_Home}/wlserver_10.3/common/bin to create WebLogic Domain. Create a domain either for standalone or for cluster as per the Oracle WebLogic documentation.

2. During domain creation it will ask for username and password for the domain. By default, Chordiant Foundation Server expects the username as system and password as weblogic$. If you want to use something else then follow the steps below to regenerate the configfile and keyfile, which will be used while deploying the application.

3. Regenerate these files by executing:

   - java -cp <path-to-weblogic_jar>\weblogic.jar
     weblogic.Admin -username username -passwordpassword -
     userconfigfile configfile -userkeyfile keyfile
     STOREUSERCONFIG
   - Type "Y" to create the key file.
Configuring Database Server

Configuring Oracle

Chordiant Foundation Server uses Type 4 JDBC connectivity to access an Oracle database. Therefore the Oracle JDBC driver files are required on the machine hosting Application Server. You are not required to install Oracle on the same machine as that of the application server; however, you could choose to do so for Development Environment in order to access other Oracle tools.

- If Oracle client/server is not installed on the same machine as that of Application Server, ensure that JDBC Type 4 Driver Files are copied to the development environment to any location with following structure:
  \{somelocationX}\JDBC\lib

  For example, C:\CFS\JDBC\lib\ojdbc6.jar

- Configure listener.ora and tnsnames.ora to use tools to access the database using TCP/IP connectivity.

Configuring DB2 for Chordiant

Chordiant Foundation Server uses either Type 2 or Type 4 JDBC connectivity to access a DB2 database.

- If Type 2 JDBC connectivity is used then the DB2 Client needs to be installed on the machine hosting Application Server. This requires cataloging the instance node and database on the client.

- If Type 4 JDBC connectivity is used then make sure that Type 4 Driver Files are copied to the machine hosting Application Server to any location with following structure:
  \{somelocationX}\JDBC\lib

  For example, C:\CFS\JDBC\lib\db2jcc4.jar and C:\CFS\JDBC\lib\db2jcc_license_cu.jar

Preparing Chordiant Database

Setting up Oracle Database

1. Create a database manually or using the Oracle Database Configuration Assistant. You can use any name for your database. The examples in this document use CHRD for the database name.
**Note:**

For Unicode support, ensure the database character set is set to AL32UTF8. Oracle supports two types of character semantics, **BYTE** (default) and **CHAR**. To handle multi-byte character strings set the initialization parameter **NLS_LENGTH_SEMANTICS** to CHAR instead of by default BYTE after database creation using the command below.

A database restart is essential for the semantics change to work.

```
sqlplus sys/{sys_password}@{db_name}
ALTER SYSTEM SET NLS_LENGTH_SEMANTICS = CHAR;
SHUTDOWN IMMEDIATE;
STARTUP;
```

2. Perform the following steps only if you are running Oracle server on the Windows platform.
   - Close the Oracle HTTP Service command window, if it is open.
   - In the Windows Control Panel, select Administrative Tools | Services, and change the Oracle HTTP Service (Server) startup setting to manual.

3. At command prompt, ensure that the ORACLE_SID is set to the database name created in step 1. Start SQL Plus, and connect as the SYSTEM user.

4. Create the following three tablespaces. The names and sizes here are suggestions for default installation, but will vary depending on your requirements.
   - DEV of size 50M
   - IDX of size 30M
   - SBOX of size 10M

Example commands are shown below:

**For UNIX:**

```
cREATE TABLESPACE dev
LOGGING
DATAFILE '/export/oramnt2/oradata/chrd/dev01.dbf' SIZE 50M
AUTOEXTEND ON NEXT 1280K MAXSIZE UNLIMITED
EXTENT MANAGEMENT LOCAL SEGMENT SPACE MANAGEMENT AUTO;
```
<table>
<thead>
<tr>
<th>Create Tablespace</th>
<th>Log Location</th>
<th>Size</th>
<th>Autoextend</th>
<th>Maxsize</th>
<th>Extent Management</th>
<th>Segment Space Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>idx logging</td>
<td><code>/export/oramnt1/oradata/chrd/idx.dbf</code></td>
<td>30M</td>
<td>on next 1280K</td>
<td>unlimited</td>
<td>local</td>
<td>auto</td>
</tr>
<tr>
<td>sbox logging</td>
<td><code>/export/oramnt2/oradata/chrd/sbox.dbf</code></td>
<td>10M</td>
<td>on next 320K</td>
<td>unlimited</td>
<td>local</td>
<td>auto</td>
</tr>
<tr>
<td>dev logging</td>
<td><code>c:\oracle\oradata\chrd\devdb01.dbf</code></td>
<td>50M</td>
<td>on next 1280K</td>
<td>unlimited</td>
<td>local</td>
<td>auto</td>
</tr>
</tbody>
</table>

**For Windows:**

<table>
<thead>
<tr>
<th>Create Tablespace</th>
<th>Log Location</th>
<th>Size</th>
<th>Autoextend</th>
<th>Maxsize</th>
<th>Extent Management</th>
<th>Segment Space Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>idx logging</td>
<td><code>c:\oracle\oradata\chrd\idx.dbf</code></td>
<td>30M</td>
<td>on next 1280K</td>
<td>unlimited</td>
<td>local</td>
<td>auto</td>
</tr>
<tr>
<td>sbox logging</td>
<td><code>c:\oracle\oradata\chrd\sbox.dbf</code></td>
<td>10M</td>
<td>on next 320K</td>
<td>unlimited</td>
<td>local</td>
<td>auto</td>
</tr>
</tbody>
</table>
Note: Modify tablespace names and paths for the location of the physical data files based on your organization’s standards and Oracle’s installation location in your environment.

5. Create two roles. Suggested role names are r_ccsown and r_ccsus.
   - r_ccsown: This role, granted to ccsowner, has two built-in Oracle roles: connect, resource, and a privilege create view.
   - r_ccsus: This role, granted to pduser, has create session, create table, and create synonym privileges.

Example commands are shown below:

```sql
create role r_ccsown;
grant connect, resource, create view to r_ccsown;
create role r_ccsus;
grant create session, create table, create synonym to r_ccsus;
```

6. Create two users with appropriate privileges. Suggested names and default passwords are ccsowner/ferrari and pduser/mappings.
   - name: ccsowner/password: ferrari
     A user who owns the regular Chordiant database schema objects. These objects include tables, views, and constraints. You should assign its default tablespace to the Chordiant DEV tablespace.
   - name: pduser/password: mappings
     A user who does not own the regular Chordiant database schema objects, but uses them through Chordiant applications. Assign this user’s default tablespace to the sbox tablespace. In addition to necessary privileges being granted to the user, a set of synonyms is required to allow this user to gain access to the Chordiant schema objects.

Example commands are shown below:

```sql
create user ccsowner
identified by ferrari
default tablespace dev
```
temporary tablespace temp
quota unlimited on dev
quota unlimited on idx;

grant r_ccsown to ccsowner;
create user pduser
identified by mappings
default tablespace sbox
temporary tablespace temp
quota unlimited on sbox
quota 0 on dev
quota 0 on idx;

grant r_ccsusr to pduser;

7. The Chordiant Oracle Database requires an installed JVM with XA enabled. A JVM is installed by default on a typical database creation through the Database Configuration Assistant (DBCA). If the database is not created as part of a typical installation, the DBA must verify that the JVM is installed and running.

– If the JVM is not installed, execute the `initjvm.sql` script with:

```
sqlplus sys/{sys-password}@{db_name} as sysdba @ initjvm.sql
```

**Note:** Ensure that all the requirements for running `initjvm.sql` have been met before executing the script.

– To enable Oracle XA Interface usage in the database, the Oracle DBA must ensure the view `DBA_PENDING_TRANSACTIONS` is present and selectable by the user or the Oracle role PUBLIC:

```
sqlplus sys/{sys_password}@{db_name}
grant select on DBA_PENDING_TRANSACTIONS to {username};
```

OR
sqlplus sys/{sys_password}@ {db_name}

grant select on DBA_PENDING_TRANSACTIONS to PUBLIC;

8. Ensure the Oracle Listener is running and automatic registration of the database instance has taken place.

To check the status of the listener from a command line, type:

lsnrctl status

To start the listener from a command line, type:

lsnrctl start

Setting up DB2 Database

Note: The installation document assumes that DB2 and your Application Server will be installed on the same machine. If this is not the case, then have your Database Administrator install and configure the DB2 client software on the machine where the Application Server is installed.

1. Create an Operating System user on the database server machine. The defaults are:

   User: ccsowner; Password: ferrari

2. Connect to the DB2 server instance as the DB2 admin user. The default is db2admin on Windows, and db2inst1 on UNIX.

3. Create the database. This can be done via the Control Center utility using the Create Database wizard or manually.

   Using Create Database wizard
   – Select Create Database using Wizard.
   – Enter the database name (default is CHRD) and click Next.
   – Accept the default settings and click Next until you reach the step Region - Specify locale for this database.
   – Set the Code Set to UTF-8 and click Finish.
   – Exit the Control Center.

   Note: The database code set of UTF-8 makes the database Unicode compliant.

4. Create necessary Buffer Pools. The default buffer pool is named BP_32K of 32K page size and with a size of 1000 pages.
5. Activate the Buffer Pool by deactivating and reactivating the database. In Control Center, disconnect and connect to the database as instance owner.

6. Create a system temporary tablespace. The default name is **temp_32k**. In the Control Center utility, use the `create, tables` option and specify these settings:
   - Tablespace Type: System
   - Space management by: System
   - Advanced options: pagesize of 32K, using bufferpool with 32K pagesize.

7. Create a data tablespace in the database. The default Tablespace name is **dev_32k**. In the Control Center utility, use the `create, tables` option and specify these settings:
   - Tablespace Type: Regular
   - Space management by: Database
   - Container with file size at least 50M (default name **dev_32k.dat**)
   - Advanced options: pagesize of 32K, extentsize (default), Prefetch size (default), using bufferpool with 32K pagesize. The default is **BP_32K**.
   - Comment “Data Tablespace”

8. Create an index tablespace in the database. The default name is **idx_4k**. In the Control Center utility, use the `create, tables` option and specify these settings:
   - Tablespace Type: Regular
   - Space management by: Database
   - Container with a file size of at least 30M (default name **idx_4k.dat**)
   - Advanced options: `pagesize` of 4K, `extentsize (default)`, Prefetch size (default), using a `bufferpool` with 4K `pagesize` (default `IBMDEFAULTBP`)
   - Comment “Index Tablespace”

9. Create a schema in the database for user ccsowner.
   - Create a schema (default name ccsowner).
   - Use authorization name ccsowner or equivalent.
   - Set comment to Chordiant Owner Schema.

10. Add operating system user ccsowner or equivalent to the database with appropriate privileges. In the Control Center utility:
    - Select **Add User** and select the **Database** tab. Then select the authorities: **Connect database, Create tables, Create packages**.
    - Select the Tablespace tab.
– Add the tablespace dev_32K and grant USE privileges with No Grant option.
– Add the tablespace idx_4K and grant USE privileges with No Grant option

11. Right-click the database CHRD and select Refresh

12. Right-click CHRD again, and select Restart.

**Note:** In a production environment, one can choose to create a database with bufferpools and tablespaces of multiple pagesizes. If so, manually modify the database setup commands appropriately. This also requires updates to the DDL scripts used during Third Party setup of Database. Ensure use of appropriate tablespaces before running the DDL scripts on the database.

### Database Creation Commands

**Note:** The database can be created by running the commands below using the command window, or individually through CLP. The commands create a Chordiant database, in this case chrd, along with default bufferpools, tablespaces, and schemas. Modify per environment needs. The commands can be used on both UNIX and Windows environments. However, for a windows environment change the path and instance name per environment.

1. If running the commands from a client, attach to the node from the client before executing the remaining steps.

```
ATTACH TO {node_name_as_cataloged} USER db2inst1 USING db2inst1;
```

2. Deactivate and drop the database, if existing.

```
FORCE APPLICATION ALL;
DEACTIVATE DATABASE chrd USER db2inst1 USING db2inst1;
DROP DATABASE chrd;
```

3. Create the Chordiant database.

```
CREATE DATABASE chrd ON /home/db2inst1 ALIAS chrd USING CODESET UTF-8 TERRITORY US COLLATE USING SYSTEM WITH 'Chordiant FS V9.7 Database';
```

4. Connect to the Chordiant database.

```
CONNECT TO chrd USER db2inst1 USING db2inst1;
```
5. Create a buffer pool. For example, BP_32K using pagesize 32K:

```
CREATE BUFFERPOOL BP_32K SIZE 1000 PAGESIZE 32 K;
```

6. Create a Temporary tablespace. For example, temp_32k using 32K pagesize.

```
CREATE SYSTEM TEMPORARY TABLESPACE temp_32k PAGESIZE 32K MANAGED BY SYSTEM USING('/export/vol01/db2inst2/db2inst2/NODE0000/chrd/T0000005/temp_32k.tmp') EXTENTSIZE 32 OVERHEAD 10.5 PREFETCHSIZE 32 TRANSFERRATE 0.14 BUFFERPOOL BP_32K;
COMMENT ON TABLESPACE temp_32k IS '32K Temporary Tablespace';
```

7. Create a Chordiant data tablespace. For example, dev_32k of size 50M with 32K pagesize.

```
CREATE REGULAR TABLESPACE dev_32k PAGESIZE 32 K MANAGED BY DATABASE USING ( FILE '/export/vol01/db2inst2/db2inst2/NODE0000/chrd/T0000003/dev_32k.dat' 6400) EXTENTSIZE 8 OVERHEAD 10.5 PREFETCHSIZE 8 TRANSFERRATE 0.33 BUFFERPOOL BP_32k;
COMMENT ON TABLESPACE dev_32k IS '32K Data Tablespace';
```

8. Create a Chordiant index tablespace. For example, idx_4k of size 30M with 4K pagesize.

```
CREATE REGULAR TABLESPACE idx_4k PAGESIZE 4 K MANAGED BY DATABASE USING ( FILE '/export/vol01/db2inst2/db2inst2/NODE0000/chrd/T0000004/idx_4k.dat' 7680) EXTENTSIZE 8 OVERHEAD 10.5 PREFETCHSIZE 8 TRANSFERRATE 0.33 BUFFERPOOL IBMDEFAULTBP;
COMMENT ON TABLESPACE idx_4k IS '4K Index Tablespace';
```

9. Create the Chordiant schema.

```
CREATE SCHEMA ccsowner AUTHORIZATION ccsowner COMMENT ON SCHEMA ccsowner IS 'Chordiant Schema';
```

10. Add Chordiant users to the database and grant necessary privileges. This requires users ccsowner is already created on the operating system.

```
GRANT CONNECT, CREATETAB, BINDADD ON DATABASE TO USER ccsowner;
GRANT USE OF TABLESPACE dev_32k TO USER ccsowner;
GRANT USE OF TABLESPACE idx_4k TO USER ccsowner;
```
11. Disconnect from the Chordiant Database.
   ```sql
   CONNECT RESET;
   ```

12. If running the script from a client, detach the client from the node when all steps have been executed.
   ```sql
   DETACH;
   ```

To create a DB2 database using a script:

1. The commands in above steps can be added in proper sequence to a file, example, and `cr_chrd.sql`. Modify the script for the instance name, database name, username, password, and paths suitable to your environment.

2. Run the modified script in the DB2 command window.
   ```sql
   db2 -tvf cr_chrd.sql -z cr_chrd.log
   ```
Configuring OpenDS Directory Server

Follow these steps after installing OpenDS Directory Server.

Click on the New Base DN on the OpenDS Directory Server Console and create a data source with the base domain name.

For example: value for Base DN "ou = People, dc = pega-epc, dc = com".

Starting the Directory Server Console

To log onto the Directory Server Console, use the following procedure:

For UNIX:
From the command prompt, run \{LDAP_Home\}/bin/start-ds.sh.

For Windows:
Double-click the \{LDAP_Home\}/bat/start-ds.bat file.

Stopping Directory Server

For UNIX:
From the command prompt, run \{LDAP_Home\}/bin/stop-ds.sh to stop the Directory Server, use the following procedure:

For Windows:
Double-click the \{LDAP_Home\}/bat/stop-ds.bat file.

Launch the Control Panel

To start the Control Panel, use the following commands:

- For UNIX: From the command prompt, run \{LDAP_Home\}/bin/control-panel.sh
- For Windows: From the command prompt, run \{LDAP_Home\}/bat/control-panel.bat
Configuring Web Server for Cluster

You need to install and configure Web server for a clustered environment. Chordiant Foundation Server is certified with IBM HTTP Server for WebSphere cluster and Apache HTTP Server for WebLogic Cluster. In this section, you will come to know how to configure both of them after you have installed the same following the guidelines from the respective vendors.

Configuring IBM HTTP Server for WebSphere Cluster

1. Make sure that mod_was_ap22_http.so file exists at {IBMHttpServer_Installed_Location}/Plugins/bin. If not, download and copy this file.
2. Copy the plugin-cfg.xml file generated from WebSphere Application Server to {IBMHttpServer_Installed_Location}/conf

   **Note:** How to generate plugin-cfg.xml from WebSphere is covered latter in this document under Failover in WAS.

Configuring Apache HTTP Server for Weblogic Cluster

1. Copy the wls_mod_22.so file from Weblogic server installation location, {Weblogic_Home}/wlserver_10.3/server/plugin/solaris/sparc/ folder into {Apache_Insllation_Location}/modules/ folder.
2. Copy chordiant_cluster.conf file to conf folder of Apache HTTP Server. Modify the file as it contains the cluster settings.
   - Add one line for wls_mod22.so file
     WebLogic Module LoadModuleweblogic_module
     modules/mod_wl_22.so
   - Add one line for chordiant_cluster.conf file
     Include
     {Apache_Installation_Loc}/conf/chordiant_cluster.conf
   - Add the line
     ServerName <Sever IP>:80
   - Modify:
     Listen <Server IP>:80
Chapter 3:
Configuration Notes

This chapter lists out the required configurations.
MDB Configuration

The design of the Chordiant MDBs was based on there being a guaranteed single instance. If the number of MDB's is greater than one, then it needs to be changed to one MDB instance.

For WebSphere Application Server

In the console under ApplicationServers | ChordiantAppServer | Message Listener Service | Thread pool screen, input 1 as the minimum and maximum size of threads and click Apply.

For WebLogic Server

- Locate and open the ChordiantEJB\src\META-INF\weblogic-ejb-jar.xml file into an editor.
- Perform the following changes:

```xml
<weblogic-enterprise-bean>
<ejb-name>SessionTopicMDB</ejb-name>
<message-driven-descriptor>
<pool>
<max-beans-in-free-pool>1</max-beans-in-free-pool>
<initial-beans-in-free-pool>1</initial-beans-in-free-pool>
</pool>
<destination-jndi-name>jms/com_chordiant_session_SessionTopic</destination-jndi-name>
</message-driven-descriptor>
<transaction-descriptor></transaction-descriptor>
</weblogic-enterprise-bean>
```

- Re-deploy the ChordiantEar and restart the server.
Performing Set-up and Configuration

Development Environment Configuration

**MyEclipse/WebLogic Server**

Copy the `wlntio.dll` file from

\<weblogic_installation\>\wlserver_10.3\server\native\win\32 to
\<weblogic_installation\>\jdk160_24\bin

**NOTE:** If you have not copied this DLL file you may observe error messages like the one shown below. This error has no impact on functionality of the application.

```
<Error> <Socket> <BEA-000438> <Unable to load performance pack. Using Java I/O instead. Please ensure that wlntio.dll is in: 'C:\weblogic\jdk160_24\bin'>
```

Production Environment - Cluster Configuration

**WebSphere Server**

Change the value for “com.chordiant.instance” for each server in the cluster. For first server the value will be 1 for second server the value will be 2 and so on.

To change the value for this parameter, Go to admin console and do the following:

1. Go to **Servers | Server Type.** Select **WebSphere Application Server.**

2. **{ServerName} | Java and Process Management | Process Definition | Java Virtual Machine | Custom properties**

3. Click the parameter **com.chordiant.instance** and change its value as shown below:
4. Click Apply and Save the changes.

5. Change all localhost with respective server name in the same page of Custom properties.

6. Restart the servers.

**WebLogic Server**

Change the value for `-Dcom.chordiant.instance` for each server in the cluster. For first server the value will be 1 for second server the value will be 2 and so on.

To change the value for this parameter, follow the steps:

1. Go to bin location of your domain.
   - Change the value for `-Dcom.chordiant.instance='<value>'`,
   - Where Value could be “1”, “2” for 1st server and 2nd server respectively.

**FMX and CTI Configuration**

In order to work with Foundation Server Administration Tools like FMX Console and CTI Administration Tool, it is mandatory to configure following JVM parameters at server side.

**WebSphere Server**

You need to configure two parameters:

- `AdminServerHost={host name/IP Address of the Deployment Manager node}`
- `AdminServerPort={BOOT Strap port of the Deployment Manager node}`
Note:

For Development Environment: AdminServerHost will be localhost and AdminServerPort will be BOOT Strap port of the server.

For Production Environment: AdminServerHost will be host name/IP Address of Deployment Manager node and AdminServerPort will be port of BOOT Strap of Deployment Manager. For Cluster these parameter needs to be set for each server.

To set these parameters in either Development or Production environment follow these steps:

1. Launch the WebSphere Administration Console.
2. Go to Servers > Server Types > WebSphere Application servers > {select the server}.
4. Create the above two parameters. See Figure below.

![Figure 3-2: Adding Parameters](image)

5. Apply the new settings and restart the server.

WebLogic Server

You need to configure two parameters:

- `-DAdminServerHost={host name/IP Address of the Admin Server Host}`
- `-DAdminServerPort={Listen port of the Admin Server Host}`
**Note:**

**For Development Environment**: -DAdminServerHost will be localhost and -DAdminServerPort will be listen port of the server (by default 80)  

**For Production Environment**: -DAdminServerHost will be host name/IP Address of Admin Sever and -DAdminServerPort will be listen port of Admin Server. *For Cluster these parameter needs to be set for each server.*

To set these parameters in Development environment follow these steps:

1. Go to Window>Preferences >MyEclipse >Servers >WebLogic (server version) >JDK  
2. Add these properties on the dialog Optional java VM arguments  
3. Create the above two parameters.  
4. Apply the new settings and restart the server

![Figure 3-3: Adding Parameters in Development Environment](image)

To set these parameters in Production environment follow these steps:

1. Go to bin location of your domain.  
3. Add these two parameters in JAVA_OPTION.  
4. Restart the server.
JSF configuration for WebSphere 8

**Note:** This setting is only required if JSF 1.2 is used

1. Change the Settings in Application Server: `server1 > Installed Applications > ChordiantEAR > JSP and JSF Options`.

2. Select **Sun Reference Implementation 1.2** from the drop-down.

![Figure 3-4: Application server settings](image)
Miscellaneous Configurations

WebLogic Upgrade

Continuous warning messages as shown below have been observed after upgrade to WebLogic 10.3.5.

<Warning> <Socket> <BEA-000450> <Socket 533 internal data record unavailable (probable closure due idle timeout), event received -32>

Note: These warning messages in the server console do not affect any functionality.

Resolution:
1. Open the WebLogic Administration Console by typing http://<HOST_NAME>:<PORT_NUMBER>/console in your browser.
2. In the navigation tree, click Domain name > Servers > Server name.
3. In the right pane, select the Protocols > General tab
4. Set Idle Connection Timeout and Tunneling Client Timeout values
5. Restart WebLogic for the new settings to take effect.

EJB/JEE Timer Service

Refer the Business Process Server Developers Guide for the steps to configure EJB/JEE Scheduler for WebLogic and WebSphere Cluster.

Comet

For Comet related configurations, refer Foundation Server Developer’s Guide.

Changing Configurations Dynamically

Foundation Server provides the ability of changing configurations dynamically. For more information, refer Foundation Server Developer’s Guide.

Browser Agnostic Application

For configuring your application to be browser agnostic, refer the Foundation Server Browser Agnostic Application Developer’s Guide.
Chapter 4: Installing Chordiant Decision Management

This chapter describes how to install, configure and validate Chordiant Decision Management (CDM) on Foundation Server.

Note: You should install this only if you are a CDM customer. If you have an issue with the installation, contact Chordiant Customer Support.
Overview

The decision service enables any Foundation Server application to make decisions by interacting with the CDM components based on simple or complex inputs. Use of the Foundation Server decision service requires a valid license for the CDM product. The decision service does not store any decision data.

Specialized decision tasks are available in the Business Process Designer application so workflow can access CDM. Refer to the Chordiant Foundation Server Business Process Server Developer’s Guide for more information.
Installing CDM

Pre-Installation Task

Before performing the procedures described in the following section, Chordiant Foundation Server environment should be installed.

CDM Installation

Installing CDM with foundation includes the following tasks:

- Configure CDM Database
- Run CDM J2EE Installer:
  - Run the CDM J2EE Installer on the application server and deploy the CDM EARs
  - Restart the application server and check the log file to ensure the application server is running correctly
- Verify the CDM installation
  - Deploy decision logic to CDM
  - Run the decision tester to validate the decision service integration

Configure Database

Before proceeding to the installation process, you need to setup the Database.

Refer to the Chordiant Decision Management Runtime Installation Guide for more information on the database configuration.

Run CDM J2EE Installer

Chordiant Decision Management provides the tool 'CDM J2EE Installer' which creates the resources required by the Chordiant Decision Management suite for runtime applications. The CDM J2EE Installer is available for WebSphere application servers. Depending on the application server choose appropriate installer to run the CDM setup.

Refer to the installation steps provided under J2EE CDM Installer section of Chordiant Decision Management Runtime Installation Guide to install Chordiant Decision Management modules. This manual is available on CDM CDs or available for download from Pega Mesh®.
**Note:** In order to run the **CDM J2EE Installers**, modify the path variables in `install.bat` with respect to the execution environment.

For example:

**WebLogic:**

```
set WLS_HOME=C:\bea
set WLS_LIB=%WLS_HOME%\wlserver_10.3\server\lib
set JAVA_HOME=%WLS_HOME%\jdk160_05
```

**WebSphere:**

```
set APP_SERVER_HOME=C:/Program Files/IBM/WebSphere/AppServer
set JAVA_HOME=%APP_SERVER_HOME%/java
```

1. Add the following jar files to the `ChordiantEAR/lib`
   2. For WebLogic: `is_wls_client.jar` and `rtds_wls_proxyclient.jar`
   3. For WebSphere: `is_was_client.jar` and `rtds_was_proxyclient.jar`

4. Configure the tags below from `Decision.xml` file located in Foundation Server's `ChordiantEAR/config/chordiant/components/master` directory.
   - `RTDSUrl`
   - `RTDSInitialContextFactory`

For Example:

**WebLogic:**

```
<Tag>RTDSUrl</Tag>
   <Value>t3://localhost:80</Value>
</Tag>
<Tag>RTDSInitialContextFactory</Tag>
   <Value>weblogic.jndi.WLInitialContextFactory</Value>
```

```
```
WebSphere:

<Tag>RTDSUrl</Tag>

<Value>iiop://localhost:2810</Value>

<Tag>RTDSInitialContextFactory</Tag><Value>com.ibm.websphere.naming.WsnInitialContextFactory</Value>

</Tag>
Verification of CDM Installation

After Installing and configuring the CDM modules with Foundation Server, perform the validation steps below:

Deploy Decision Logic to CDM

1. To create a new project, from the File menu, select File | New | Project | Chordiant | Testers Project | Sample Decision Project.

2. Verify that the following files exist in the newly created project:
   - makeDecision_Age.zip
   - makeDecision_Monitoring.zip
   - makeDecision_Object.zip

3. Login to the CDM Deployment Manager and provide the required licenses to enable the CDM modules.

4. Select Configuration | System parameters and provide the required information. Click Save.

5. Select Configuration | Connections and Create a connection by providing the required information. Click Ping and Save the connection.

![Connection Details Dialog](image)

Figure 4-1: Connection Details Dialog

6. Select Configuration | Deployment environments, create a new environment by providing the required information. Add Admin user to the environment.

7. Select Decision Execution | Real-time Decisioning, click Import and browse to the real time projects which is created as per Step 1. Validate
the projects followed by **Deploy** and **Save**. The projects should be deployed successfully.

**Test Decision Logic**

1. Select **Decision Execution** | **Test Decision Logic**. Provide information as shown in Figure 4-2:

   ![Real Time Project Selection](image)

   *Figure 4-2: Real Time Project Values*

   2. Click **Next**.

   3. Expand **Input Data** and provide the desired values.

   4. Click **Apply** and expand the **Output Data** and check the output.

**Run Decision Tester**

1. To create a new project, from the **File** menu, select **File** | **New** | **Project** | **Chordiant** | **Testers Project** | **Testers Project**.

2. Add the `decisiontesters.jar` from the `{Tester Project}/lib` to ChordiantEAR/lib.

3. Update the ChordiantEJBmanifest file.

4. Re-deploy the ChordiantEAR and restart the application server.

5. Login to the CDM Deployment Manager application, define a proposition type and create a proposition. To define **proposition**, select **Propositions** | **Proposition maintenance**, then click **Create**.

   - Define a proposition type with values for **Section** and its **Attribute name**.
Define a proposition with its **Name** and **Identifier** set to **offer_2a**. This data is case sensitive and must be specified exactly as shown in Figure 4-4:

```
<table>
<thead>
<tr>
<th>Name</th>
<th>offer_2a</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifier</td>
<td>offer_2a</td>
</tr>
</tbody>
</table>
```

**Figure 4-4: Proposition Values**

6. Restart the application server.

7. Run the decision target in the `jxtesters` Ant script located in `{Tester project}` as shown below:

```xml
<target name="decision" depends="_init" description="Decision tester">
  <java fork="true" classname="com.chordiant.decision.test.TestClient" classpathref="classpath">
    <property name="preExecute" value="false"/>
    <property name="postExecute" value="false"/>
  </java>
</target>
```

The Decision Testers call the Decision service which enables any application to make decisions by interacting with the Chordiant Decision Management (CDM) component based on simple or complex inputs.

The tester should execute successfully.
Chapter 5:
Configuring Multiple Web Applications

Chordiant’s thin-client applications, such as Call Center Advisor – Browser Edition, Administration Manager, Business Activity Manager and FMX Console can be configured as separate web applications.
Configuration Steps

For enabling multiple application features, few methods in CAFE have been deprecated and are available with their alternatives. For more details refer section **Deprecated API’s** in *Foundation Server Upgrade guide*.

**Tip:** If your custom code is using any deprecated API, it is recommended to change the custom code to the alternative API.

Perform the following steps to configure multiple web applications:

1. Create Advisor module as described in Chapter 4 of *Foundation_Server_DE_Guide*. Repeat the same steps for the other web modules by selecting required bundles while creating CAFE Bundle project. E.g., for the Administration Manager module, create CAFE Bundle by selecting the Administration Manager Bundles along with Foxberry bundles and then create CAFE WAR for Admin Manager.

   **Note:** Foxberry bundles are required when JSF is used in the web module. In multiple web applications, at least one application needs to be named as “Advisor”.

2. Create a New Web Application project. For example, Admin and extract the Advisor.war file from the CAFE WAR project (created in step 1).

   **Note:** To differentiate from Advisor, rename advisor.htm to admin.htm from the location {WORKSPACE}/Admin/WebRoot/

3. Run the default target of the Ant script `replace_advisor.xml` located in {WORKSPACE}/Admin/WebRoot/ by providing the valid inputs to the `input.properties` file.

   ```
   # webcontext name through which the application is accessed
   web.context.name = Admin
   # The location of webproject name
   web.project = ../../../Admin
   # Name of the CAFEWAR project (for PE Environments)
   staging.folder.name = ADMINWar
   ```

   This script replaces all the `/Advisor/` static references with the value of `web.context.name` and also archives the changes as a war file in the staging folder of `staging.folder.name`. It will also create workflow libraries for this module in ChordiantEAR\lib and JXRuntime\lib folders.
4. Do not run the Setup Chordiant Projects again.

5. Repeat the steps from 1-4 for required web applications.

   **Note:** Remove the entries in web.xml if they are not applicable to the selected bundles. E.g. In case CTI bundle is not selected while creating the application, the entries for servlets `CtiRequestHandlerServlet` and `CtiTransferActivity` should be removed from web.xml.

6. Configure the setting `IsMultipleWebApps` as `true` by overriding the following configuration of `CafeComponent.xml` in your custom configuration file.

   ```xml
   <Section>CAFE_ServerConfiguration
   <Tag>IsMultipleWebApps
   <Value>true</Value>
   </Tag>
   </Section>
   ```

7. Add all the web application projects to ChordiantEAR.

   **Note:** While creating APM project for Production Environment, select created war files from the staging folder of all the CAFEWAR projects. While creating EAR through APM, select Advisor as value for the `Cafe Application Context Root`.

8. Deploy the web application projects, according to your application server (WebLogic or WebSphere).

9. To verify the deployment, access the Admin Application using the below URL: `http://{servername}/Admin/admin.htm`

10. If required, modify the path for multiple web applications as some configuration files might have reference to these two elements `AP_WEB_APP` and `AEP_ADVISOR_ROOT_DIRECTORY` in `master.dtd` file.

    **Example:** Advisor Component.xml has a reference to this path for the Tag A as shown below:

    ```xml
    <Tag>AvailabilityProfilesConfigFileLocation
    <Value>&AEP_ADVISOR_ROOT_DIRECTORY;/iAdvisorWeb/bundles/ccaavailability profile/xml/</Value>
    </Tag>
    ```
Behavior of Multiple Web Application Configurations

■ When a user tries to login into a desktop which the user does not have a role to access, the user is routed to the CAFE default desktop.

■ If a user has multiple desktops assigned, the Desktops menu will list only the desktops which are available in each web application.

■ When your application is configured to prevent multiple sessions for a user with multiple web applications along with multiple web applications, each session per web application is treated uniquely.

**Tip:** If a user’s role is for both Call Center Advisor and Administration Manager Desktop, the user can login into both the applications. However, user cannot login into multiple sessions for the same desktop.
Appendix A:

Troubleshooting

This chapter describes some tips for troubleshooting your installation.
RAD

RAD publish fails when setting up the following

ChordiantEAR Publish Error

If you get a publish error:

1. Open the Java EE perspective.
2. Expand the Enterprise Application in the Enterprise Explorer view.
3. Expand ChordiantEAR and double-click the Deployment Descriptor.
4. Under Modules, make sure all projects exist in your workspace.

RAD workspace location dialog box no longer displays on startup

You selected the Use this as the default and do not ask again checkbox when starting RAD, as shown in Figure A-1. Now you want to change the workspace location, but the dialog does not display.

![Workspace Launcher](image)

Figure A-1: Setting Default Workspace

1. Within RAD, select Windows | Preferences | Workbench | Startup and shutdown.
2. Select the Prompt for workspace on startup checkbox. Then click OK.
Figure A-2: RAD Preferences
WebLogic Application Server on Development Environment

Error when setting up Chordiant Projects

When setting up Chordiant projects, an error similar to the example shown in Figure A-3 appears.

![Error on WebLogic when setting up Chordiant Projects](image)

**Figure A-3: Error on WebLogic when setting up Chordiant Projects**

This error occurs when WebLogic Application Server attempts to use the same port as another application that is running. To resolve the problem, change the WebLogic Port setting in the Port tab (the default setting is 80) to another number and click OK.
Network

Security Error Message

The client application displays a “security error” message, and the Java Console on the application server shows security/permissions exception error messages stating that the browser was unable to create the network presence socket server.

The Java Console loaded on the client machines must match, or be close to, the version of the JRE used by the application server. Bringing the versions of Java in line with each other corrects the problem.
Appendix B:

Required Information Checklist

When installing and configuring supporting third-party software, record the information described in the following tables. This information will be required when you configure your Chordiant installation in the Tools Platform.
# Application Server

<table>
<thead>
<tr>
<th>REQUIREMENT</th>
<th>DESCRIPTION</th>
<th>VALUE (RECORD HERE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administration Tool socket gateway service connection port</td>
<td>Gateway used for the system.</td>
<td></td>
</tr>
<tr>
<td>J2C alias name</td>
<td>Java 2 connection authentication data entry used by the resource adapters and JDBC data source.</td>
<td></td>
</tr>
<tr>
<td>Listen address</td>
<td>Name of the server where WebLogic is running.</td>
<td></td>
</tr>
<tr>
<td>Listen port</td>
<td>Port number used to connect to the Chordiant server.</td>
<td></td>
</tr>
<tr>
<td>Node name</td>
<td>Name of the system where the application server is installed.</td>
<td></td>
</tr>
<tr>
<td>Bootstrap port</td>
<td>ORB bootstrap port to use if you are connecting through RMI.</td>
<td></td>
</tr>
<tr>
<td>SOAP port</td>
<td>Connector port to use if you are connecting through SOAP.</td>
<td></td>
</tr>
<tr>
<td>Server name</td>
<td>Name of the application server.</td>
<td></td>
</tr>
<tr>
<td>Virtual host name</td>
<td>Logical name used to configure web applications to a particular host name.</td>
<td></td>
</tr>
<tr>
<td>VRU socket port</td>
<td>Port that Chordiant uses to communicate with the VRU.</td>
<td></td>
</tr>
<tr>
<td>Shutdown socket port</td>
<td>Port where Foundation Server listens for the shutdown command.</td>
<td></td>
</tr>
</tbody>
</table>
## Database

<table>
<thead>
<tr>
<th>REQUIREMENT</th>
<th>DESCRIPTION</th>
<th>VALUE (RECORD HERE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database client location (DB2 only)</td>
<td>Location where the DB2 client is installed.</td>
<td></td>
</tr>
<tr>
<td>Database host name</td>
<td>Physical name of the database server in your environment.</td>
<td></td>
</tr>
<tr>
<td>Database name</td>
<td>Name of the Oracle database instance associated to the Chordiant database, or the alias or name of the DB2 Chordiant database.</td>
<td></td>
</tr>
<tr>
<td>Database owner/password</td>
<td>User who owns the regular Chordiant database schema objects. The defaults are ccsowner/ferrari.</td>
<td></td>
</tr>
<tr>
<td>Database port number</td>
<td>Port that connects to your Chordiant database. For Oracle, the default port is 1521. For DB2, the default port is 5000.</td>
<td></td>
</tr>
<tr>
<td>Database user/password</td>
<td>User who does not own the regular Chordiant database schema objects, but uses them through Chordiant applications. The defaults are pduser/mappings.</td>
<td></td>
</tr>
<tr>
<td>Non-transactional data source name</td>
<td>JDBC connection that does not support transactions.</td>
<td></td>
</tr>
<tr>
<td>Tablespace names (dataspaces and indexspace)</td>
<td>For data and indexes. The defaults are DEV and IDX.</td>
<td></td>
</tr>
<tr>
<td>Transactional data source name</td>
<td>JDBC connection that supports transactions.</td>
<td></td>
</tr>
</tbody>
</table>
## LDAP

<table>
<thead>
<tr>
<th>REQUIREMENTS</th>
<th>DESCRIPTION</th>
<th>VALUE (RECORD HERE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administration Manager email address</td>
<td>Email address used by the profile manager to send administration-related emails.</td>
<td></td>
</tr>
<tr>
<td>SMTP server name</td>
<td>Name of the SMTP server that the Profile Manager can use to send emails.</td>
<td></td>
</tr>
<tr>
<td>Administrator password</td>
<td>Password used to log into Directory Server.</td>
<td></td>
</tr>
<tr>
<td>Location of OpenDS Directory Server installation</td>
<td>Drive and directory where OpenDS Directory Server LDAP is installed.</td>
<td></td>
</tr>
<tr>
<td>Security authentication domain name</td>
<td>Base DN of the authentication domain.</td>
<td></td>
</tr>
<tr>
<td>Security authentication host name</td>
<td>Name of the server where LDAP is installed.</td>
<td></td>
</tr>
<tr>
<td>Security authentication organizational unit</td>
<td>Subtree that contains the users.</td>
<td></td>
</tr>
<tr>
<td>Security authentication port number</td>
<td>LDAP server port number.</td>
<td></td>
</tr>
<tr>
<td>User profile cache size</td>
<td>Number of users to hold in cache.</td>
<td></td>
</tr>
</tbody>
</table>
## JMS Server

<table>
<thead>
<tr>
<th>REQUIREMENT</th>
<th>DESCRIPTION</th>
<th>VALUE (RECORD HERE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>JMS J2C Alias Name</td>
<td>Java 2 connection authentication data entry to be created that will be used by the resource adapters and JDBC data source.</td>
<td></td>
</tr>
<tr>
<td>Service Integration Bus Name</td>
<td>Name of the service integration bus.</td>
<td></td>
</tr>
</tbody>
</table>
### JDK

<table>
<thead>
<tr>
<th>REQUIREMENT</th>
<th>DESCRIPTION</th>
<th>VALUE (RECORD HERE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java runtime location</td>
<td>Location where the Java runtime is installed.</td>
<td></td>
</tr>
</tbody>
</table>